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C h a p t e r

Survey, Points, and Linework

This chapter focuses on automated Field to Finish tools that aid in drafting an 
accurate and efficient Existing Conditions Plan. These tools create a correct 
existing topography, property lines, right-of-ways, and center line locations based 
on survey data collected in the field. You will learn how to create parcels from a 

legal description using the Autodesk® Civil 3D® Lines and Curves commands and 
the transparent commands. The chapter also covers the important topic of Civil 
3D Styles and how they are managed. Styles will be modified and new styles will 
be created.

Learning Objectives in This Chapter

• List the steps used to create linework from coordinate files, in a typical survey workflow.

• Create a figure database for stylizing linework automatically.

• Create point marker and label styles to annotate points.

• Set the appropriate point creation settings and the next available point number.

• Create points manually using the Create Points toolbar.

• Assign point symbols, labels, layers, etc., automatically when importing points by setting up 
Description Key Sets.

• Import points from ASCII files created from the field survey.

• Group points together using common properties, such as name, elevation, description, etc.

• Review and edit points using the Panorama window to ensure accuracy.

• Share information about points used for error checking or stake out points using predefined 
reports.

• Draw parcels from a legal description.
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2.1 Survey Workflow Overview

Workflow To create linework from coordinate files, use the following survey 
workflow:

1. Data needs to be entered into the data collector. The correct 
language, methodology, and basic rules regarding data entry 
into the data collector begin with an understanding of Figure 
Commands and Field Codes (raw descriptions).

2. Data can be transferred from the data collector to the 
computer using an ASCII file or an electronic field book. An 
ASCII file can be opened in Notepad and data can be 
separated or delineated by spaces or commas. The most 
popular transfer format is Comma Delimited Point Number, 
Northing, Easting, Elevation, Description (PNEZD) format. 
This material focuses on the different types of Descriptions 
that can be entered into a data collector so that the user 
obtains the required automated symbology and linework.

3. If using an electronic field book file (a type of ASCII file), data 
needs to be converted from the raw coordinate file to a field 
book (*.FBK) using Survey Link or other methods of the 

Autodesk® Civil 3D® software. Autodesk has collaborated 
with major survey equipment vendors to develop API and 
drivers that interface their specific survey equipment (Trimble 
Link, TDS Survey Link, Leica X-Change, TOPCON Link, etc.) 
with the Autodesk Civil 3D software.

If following the Linework Code Set command format, you do 
not need to convert the coordinate file to a field book. The 
Autodesk Civil 3D software needs to have all of the 
necessary Styles, Settings, and Figure Prefixes to create, 
sort, and place points and linework on the required layers.
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2.2 Survey Figures
Survey figures consist of linework generated by coding and 
placed in a file that is imported into a Survey Database. A figure 
represents linear features (edge-of-pavement, toe-of-slopes, 
etc.).

A figure has many functions, which include: 

• Acting as linework in a drawing. 

• Acting as breaklines for a surface definition.

• Acting as parcel lines. 

• Acting as a pipe run. 

• Acting as targets for Width or Offset Targets in a Corridor.

• Acting as targets for Slope or Elevation Targets in a Corridor 
(e.g., limits of construction for a road rehab project might be 
to the face of walk, which exists in the drawing as a Survey 
Figure, hence a target).

The Figure Prefix database should be set up before importing 
any survey data to obtain the required entities in a drawing. As 
point and label styles and the Description Key Set need to exist 
before importing points, figure styles and entries in the Figure 
Prefix database need to exist before importing survey data.

Figure Styles Figure styles (found in the Toolspace, Settings tab, under 
Survey>Figures>Figure Styles) affect how the survey linework 
displays in a drawing. They should be part of your template file. 
These styles are not critical. However, to make figures work 
more efficiently, you should define the layers they use in the 
drawing.

• Figure styles are tied to the Figure Prefix database. The 
Figure Prefix database assigns a figure style to a figure that 
is imported into a drawing. 

• A figure style includes the layers for its linework and markers. 

• A marker is a symbol placed on the figure’s segment 
midpoints and end points. They call attention to the figure’s 
geometry. Although a figure style includes marker definitions, 
they typically do not display.

• In the Figure Style dialog box, the Information tab assigns a 
name to a style. The Profile, and Section tabs define how the 
marker displays in various views.
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• The Display tab defines which figure’s components display 
and which layers they use for plan, model, profile, and 
section views, as shown in Figure 2–1.

Figure 2–1

Figure Prefix
Database

The Figure Prefix database (found in the Toolspace, Survey tab) 
assigns the figure a style, a layer, and defines whether the figure 
is a surface breakline and/or lot line (parcel segment). If you did 
not define any figure styles, you should at least assign a layer to 
correctly place the figure in the drawing. Toggling on the 
Breakline property, as shown in Figure 2–2, enables you select 
all of the tagged survey figures and assign them to a surface 
without having to insert or select from a drawing. Toggling on the 
Lot Line property creates a parcel segment from the figure in the 
drawing and, if there is a closed polygon or intersecting lines to 
form an enclosure, assigns a parcel label and creates a parcel in 
the designated site.

Figure 2–2



Survey, Points, and Linework

© 2021, ASCENT - Center for Technical Knowledge® 2–5

If the Name is EOP (as shown in Figure 2–2), any figure starting 
with EOP uses these settings. This is similar to using a 
Description Key Set, except that the entry in the Figure Prefix 
database does not need an asterisk (*). The entry Name 
matches EOP-R or EOP-West or EOP-Main-East. When 
inserting survey figures in the drawing, Survey checks the Figure 
Prefix database for style or layer values.
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Practice 2a Creating Figure Prefixes

1. Open SUV1-A.dwg from the C:\Civil 3D Projects\Working\ 
Survey folder. 

You might have to 
change the draw order 
of the image to be able 
to view other objects. In 
Model Space, select the 
image, right-click, and 
select Display 
Order>Send to Back.

2. In the Toolspace, select the Survey tab. Right-click on Figure 
Prefix Databases, and select New…. Type ASCENT for the 
name.

3. Right-click on the newly created ASCENT Figure Prefix 
database, and select Make Current.

4. Right-click on the ASCENT Figure Prefix database again, 
and select Manage Figure Prefix Database….

5. Click  to create a new Figure definition. Set the following 
options, as shown in Figure 2–3:

• Change the Name to TRAIL.

• Select Breakline.

• Set Style to ASC-Road Centerline.

Any figure starting with TRAIL will now be selectable for a 
surface breakline and will use the style ASC-Road 
Centerline. As noted earlier, unlike the Description Key Set, 
an asterisk (*) is not necessary to match Trail1, Trail2, etc. 

Figure 2–3

6. Click  to create a new Figure definition. 

• Change the name to BLDG.

• Set the Breakline to No. 

• Set the Style to ASC-Buildings. 

7. Click OK to exit the dialog box.

8. Save the drawing.

Practice Objective

• Create a figure database for automatically stylizing linework when 
importing field book or ASCII files.
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2.3 Styles
Styles are preconfigured groups of settings (specific to an 
individual object type or label) that make the objects display and 
print the way you want them to. For example, in the list of surface 
styles shown in Figure 2–4, each surface style is configured 
differently to display different features, such as contours at 
different intervals and on the correct layers. The display of a 
terrain model could be changed by swapping one surface style 
for another. Styles enable an organization to standardize the 
look of their graphics by providing preconfigured groupings of 
display settings.

Figure 2–4

The two categories of styles you work with most often are Object 
Styles and Label Styles. Some objects have table styles as well. 
Object styles control how Autodesk Civil 3D objects (points, 
surfaces, alignments, etc.) display, what combination of 
components the object displays, which layers they display on, 
and many other settings. Label Styles are similar except that 
they control the text and other annotations associated with the 
objects.
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For example, an alignment object style specifies many settings 
including the layers on which to draw tangents and curve 
segments (which might be different) and the symbols to add at 
certain points as required (such as a triangle at the PI point). 
Alignment label styles include major and minor station labels, the 
display of station equations, design speeds, and similar 
annotation. By separating object and label styles, you can mix 
and match the right combination for a specific object.

Styles are the lowest items in the Toolspace, Settings tree and 
are typically dependent on other settings above them. If a style is 
given a unique setting, different from feature settings or label 
style defaults (such as a different text height), then that style is 
considered to have an override.

Label Styles

Label styles produce annotation of values from existing 
conditions or a design solution. A label annotates a contour’s 
elevations, a parcel’s number and area, a horizontal geometry 
point’s station on an alignment, etc. 

A label style can have text, vectors, AutoCAD blocks, and 
reference text. The content of a label depends on the selected 
object’s components or properties. For instance, a Line label can 
annotate bearing, distance, and coordinates, and use a direction 
arrow. A Parcel Area label can contain a parcel’s area, perimeter, 
address, and other pertinent values. A surface label can include 
a spot elevation, reference for an alignment’s station and offset, 
or other pertinent surface information. 

• To access the values of a label style, in the Toolspace, 
Settings tab, select the style, right-click on its name, and 
select Edit.

• A style’s initial values come from Edit Label Style Defaults 
and the style’s definition.

• All labels use the same interface.

• The object properties available for each label vary by object 
type.
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Each label style uses the same tabbed dialog box. The 
Information tab describes the style as well as who defined and 
last modified its contents. The values of the General tab affect all 
occurrences of the label in a drawing. For example, if Visibility is 
set to False, all labels of this style are hidden in the drawing. 
Other settings affect the label’s text style, initial orientation, and 
reaction to a rotated view.

The Layout tab lists all of a label’s components. A label 
component can be text, line, block, or tick. The Component 
name drop-down list (shown in Figure 2–5), contains all of the 
defined components for the style. When selecting a component 
name in the drop-down list, the panel displays information about 
the component’s anchoring, justification, format, and border. 

Figure 2–5
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When defining a new text component, you assign it an object 

property by clicking  (Browse) for Contents. This opens the 
Text Component Editor dialog box, as shown in Figure 2–6. The 
Properties drop-down list displays the available object 
properties. The number and types of properties varies by object 
type. For example, a parcel area label has more and different 
properties than a line label does. Once a property has been 
selected, units, precision, and other settings can be set to 

display the property correctly in the label. Click  next to 
Properties to place the property in the label layout area to the 
right.

Figure 2–6
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The values in the Dragged State tab define a label’s behavior 
when it is dragged to a new location in the drawing.

The key to having the label display correctly when it is not in the 
dragged state, is to line up the Anchor Point of the component 
with the Attachment option for the text. Each has nine options 
from which to select. The options are shown in Figure 2–7.

Figure 2–7

Lining up the square hatched Anchor Point with the circular 
hatched attachment option results in the text centered above the 
object similar to the bearing distance label shown in Figure 2–8.

Figure 2–8
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2.4 Points Overview
Survey Points are often used at the beginning of a project and 
COGO Points (for stakeout) at the end of a project. Surveyors 
collect data about existing site conditions (elevations, utilities, 
ownership, etc.) for the project. Their world is coordinates, which 
are represented by points. Each point has a unique number (or 
name) and a label containing additional information (usually the 
elevation of the coordinate and a short coded description).

There are no national standards for point descriptions in the 
Surveying industry. Each company or survey crew needs to work 
out its own conventions. There are no standards for symbols 
either. Each firm can have its own set of symbols. The symbols 
used in a submission set can be specified by the firm contracting 
the services.

Autodesk Civil 3D cogo / survey points are a single object with 
two elements: a point style and a point label style. A cogo / 
survey point definition is shown in Figure 2–9.

Figure 2–9

The following is important point information:

• A point style (no matter what it displays), an AutoCAD node, 
a custom marker, or a block is selectable with an AutoCAD 
Node object snap.

A point label is not limited to the point’s number, elevation, and 
description. A point label can contain lines, blocks, and other 
point properties. One can set up User-Defined point properties 
as well. For example, point labels might only display an elevation 
or description. This text can be manually overridden (as shown in 
Figure 2–10) or it can consist of intelligent variables that 
represent point characteristics (such as its convergence angle). 
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In assigned coordinate systems, the convergence angle is the 
difference between a geodetic azimuth and the projection of that 
azimuth onto a grid (grid azimuth) of a given point.

Figure 2–10

Point Marker Styles

A surveyor interacts with points daily. To easily use Autodesk 
Civil 3D points, you need to have a basic understanding of their 
related styles. 

The Autodesk Civil 3D software provides metric and imperial 
template files that contain several point styles: Autodesk Civil 3D 
Imperial (NCS) and Autodesk Civil 3D Metric (NCS). These two 
templates use the National CAD standards for their layers and 
provide examples of styles that you can use in a project. To 
customize these styles, you need to modify and expand the list 
of point styles. 

Customizing styles needs to be managed carefully. Consult with 
your BIM Manager as to the standards and procedures for such 
customization. If you do modify an existing style or create a new 
one, be sure to put your name or initials in the Created by: field 
for easy identification, as shown Figure 2–11.

Figure 2–11

When installing the Autodesk Civil 3D software, the first thing 
you should do is set one of these two templates as your default 
template. Alternatively, your BIM Manager can develop styles to 
be used in your organization’s drawing template file.
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A point style defines a point’s display, its 3D elevation, and its 
coordinate marker size. In the example shown in Figure 2–12, 
the point style is an X for a ground shot. 

Figure 2–12

The Point Style dialog box has five tabs: Information, Marker, 3D 
Geometry, Display, and Summary. 

The Information tab sets the point style’s name and description, 
as shown in Figure 2–13.

Figure 2–13

The Marker tab supports three marker definition methods, as 
shown in Figure 2–14.
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Figure 2–14

• Use AutoCAD POINT [node] for marker: All points in the 
drawing follow AutoCAD’s PDMODE and PDSIZE system 
variables. You do not have independent control over points 
using this option. (This option is seldom used.)

• Use custom marker: This option creates markers similar to 
an AutoCAD point (node). However, the marker is under the 
Autodesk Civil 3D software’s control, and each point style can 
display a different combination of marker styles. When using 
this option, select the components of the style from the list of 
Custom marker style shapes. A custom marker can have 
shapes from the left and right sides. The first comes from one 
of the five icons on the style’s left side, and you can optionally 
add none, one, or both shapes from the right.

• Use AutoCAD BLOCK symbol for marker: This option 
defines the marker using a block (symbol). The blocks listed 
represent definitions in the drawing. When the cursor is in this 
area and you right-click, you can browse to a location 
containing drawings that you want to include as point 
markers.
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Options for scaling the marker display in the marker panel’s top 
right corner. The most common option is Use drawing scale (as 
shown in Figure 2–15), which takes the marker size (0.1000") 
and multiplies it by the current drawing’s annotation scale, 
resulting in the final marker size. When the annotation scale 
changes, the Autodesk Civil 3D software automatically resizes 
the markers and their labels to be the appropriate size for the 
scale.

Figure 2–15

The other options are described as follows:

The 3D Geometry tab affects the point’s elevation. The default 
option is Use Point Elevation (as shown in Figure 2–16), which 
displays the point at its actual elevation value.

Figure 2–16

Use fixed scale Specifies user-defined X, Y, and Z scale values.

Use size in 
absolute units

Specifies a user-defined size.

Use size relative 
to screen

Specifies a user-defined percentage of the screen.
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The other options are described as follows:

The Display tab assigns the marker and label layers, and sets 
their visibility and properties. Setting the property to ByLayer 
uses the layer’s properties. Alternatively, you can override the 
original layer properties by setting a specific color, linetype, or 
lineweight.

A style’s view direction value affects how the point and label 
components display in the plan, model, profile, and section 
views, as shown in Figure 2–17.

Figure 2–17

The Summary tab is a report of all of the style’s settings. 
Controlling a leader arrow from a label in the dragged state, 
points to the boundary of the marker (yes) or the center of the 
marker (no). It is also changed under Marker>Leader and stops 
at marker. You can also edit style variables in this tab.

Flatten Points to 
Elevation

Specifies the elevation to which the point is projected 
(flattened). The Point Elevation cell highlights if this 
option is selected and is 0 elevation by default. 
When using an AutoCAD object snap to select a 
marker using this option, the resulting entity’s 
elevation is the default elevation of 0. If selecting by 
point number or point object, the resulting entity is 
the point’s actual elevation.

Exaggerate Points 
by Scale Factor

Exaggerates the point’s elevation by a specified 
scale factor. When selecting this option, the Scale 
Factor cell highlights.
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Point Label
Style

The Autodesk Civil 3D point label style annotates point properties 
beyond the typical point number, elevation and description. A 
typical point label style is shown in Figure 2–18.

Figure 2–18

All Autodesk Civil 3D label style dialog boxes are the same. The 
basic behaviors for a label are in the settings in the Edit Label 
Style Defaults dialog box. The values in this dialog box define the 
label layer, text style, orientation, plan readability, size, dragged 
state behaviors, etc.

In the Toolspace, Settings tab, the drawing name and object 
collections control these values for the entire drawing (at the 
drawing name level) or for the selected collection (Surface, 
Alignment, Point, etc.) To open the Edit Label Style Defaults dialog 
box, select the drawing name or a heading, right-click, and select 
Edit Label Style Defaults…, as shown in Figure 2–19.

Figure 2–19
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The Label Style Composer dialog box contains five tabs, each 
defining specific label behaviors: Information, General, Layout, 
Dragged State, and Summary.

The Information tab names the style, as shown in Figure 2–20.

Figure 2–20

The General tab contains three properties: Label (text style and 
layer), Behavior (orientation), and Plan Readability (amount of 
view rotation before flipping text to read from the bottom or the 
right side of the sheet), as shown in Figure 2–21.

Figure 2–21

The Label property sets the Text Style, Label Visibility, Layer. 
Select the Value cell next to the Text Style and Layer to open 
browsers and change their values. Selecting the Label Visibility 
cell displays a drop-down list containing the options true and 
false.
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The Behavior property sets two variables that control the label’s 
location. The Orientation Reference variable contains the three 
label orientation options.

Under the Behavior property, the Forced Insertion variable has 
three optional values that specify the label’s position relative to 
an object. This setting only applies when the Orientation 
Reference is set to Object and the objects are lines, arcs, or 
spline segments.

• Note: If you select Top or Bottom, set the value of Plan 
Readable to True.

The Plan Readability property has three variables that affect how 
text flips when rotating a drawing view. 

Under the Plan Readability property, the Plan Readable variable 
has two options.

The Readability Bias variable is the amount of rotation required 
to flip a label to become left to right readable. The angle is 
measured counter-clockwise from the WCS 0 (zero) direction. 

Object Rotates labels relative to the object’s zero direction. The 
object’s zero direction is based on its start to end vector. If 
the vector changes at the label’s anchor point, the 
orientation updates automatically. This is the default setting.

View Forces labels to realign relative to a screen-view orientation 
in both model and layout views. This method assumes that 
the zero angle is horizontal, regardless of the UCS or Dview 
twist. If the view changes, the label orientation updates as 
well.

World 
Coordinate 
System

Labels read left to right using the WCS X-axis. Changing the 
view or current UCS does not affect label rotation. The label 
always references the world coordinate system.

None Maintains label position as composed relative to the object.

Top Adjusts label position to be above an object.

Bottom Adjusts label position to be below an object.

True Enables text to rotate to maintain left to right readability from 
the bottom or right side of the drawing.

False Does not permit text to flip. The resulting text might be 
upside down or read from right to left.
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The Flip Anchors with Text variable has two options:

The Layout tab defines the label contents, as shown in 
Figure 2–22. A label component is an object property that it 
labels. Point properties include northing, easting, raw 
description, etc. If User Defined properties are in use, they will 
also be available. A label might have one component with 
several properties or several components each containing an 
object property, as well as regular text (such as Northing:).

Figure 2–22

A point style label component can be text, lines, or blocks. Other 
object type label styles can include additional components, such 
as reference text, ticks, directional arrows, etc. To add a 
component, expand the drop-down list (as shown in 
Figure 2–23) and select the component type.

Figure 2–23

True If the text flips, the text anchor point also flips.

False The label flips, but maintains the original anchor point. The 
behavior is similar to mirroring the original text.
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The remaining icons in the Layout tab are described as follows:

Depending on the label component type, it might have any 
combination of three areas: General, Text, and Border. General 
defines how the label attaches to the object or other label 
components, its visibility, and its anchor point.

If the label component is text, the Text property values affect how 
it displays its object property. To set or modify a label’s text 
value, select the cell next to Contents to display  (shown in 
Figure 2–24). Click  to open the Text Component Editor dialog 
box.

Figure 2–24

The Text Component Editor dialog box (shown in Figure 2–25), 
defines the properties that the label annotates. When creating a 
label component, double-click on the text in the right pane to 
highlight it. In the left pane, select the property that you want to 

add, set the property’s format values, and then click  to add 
the new property to the label component.

Copies the current component and its properties.

Deletes the current component.

Changes the display order of a label’s components. For example, 
use this icon to change the draw order of the label’s component 
such as text above a mask.
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Figure 2–25

It is important to maintain the process order and to remember 
that the text on the right in brackets needs to be highlighted 
before you can revise its format values on the left. 

The Dragged State tab has two properties: Leader and Dragged 
State Components. This tab defines how a label behaves when 
you are dragging a label from its original insertion point.

The Leader property defines whether a leader displays and what 
properties it displays. You can use the label’s layer properties in 
the General tab (ByLayer) or override them by specifying a 
color, as shown in Figure 2–26.

Figure 2–26
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The Dragged State Components property defines the label 
component’s display after it has been dragged from its original 
position. Select the cell next to Display to view the two display 
options, as shown in Figure 2–27.

Figure 2–27

The Summary tab lists the label component, general, and 
dragged state values for the label style. The label components 
are listed numerically in the order in which they were defined and 
report all of the current values.

As 
Composed

The label maintains its original definition and orientation 
from the settings in the Layout panel. When you select As 
Composed, all of the other values become unavailable for 
editing.

Stacked Text The label text becomes left justified and label components 
are stacked in the order listed in Layout’s Component 
Name list. When you select Stacked Text, all of the 
blocks, lines, ticks, and direction arrows are removed.
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Practice 2b Point Marker Styles

In this practice, you will create a new point style and apply it to 
an existing group of points. 

Task 1 - Add a block symbol.

1. Continue working on the drawing from the previous practice 
or open SUV1-B1-Survey-.dwg from the C:\Civil 3D 
Projects\Working\Survey folder.

The aerial image used 
in this chapter was 
attached using the 
AutoCAD® Map 3D 
FDO connection. 

2. To toggle off the aerial image, in the Home tab>Palettes 

panel, click  (Map Task Pane). When prompted, select 
ON. 

3. In the Task pane>Display Manager tab, clear the Main Site 
Imperial layer, as shown in Figure 2–28. Select Map Base 
again to clear the Raster Layer contextual tab. Close the map 
Task Pane.

Figure 2–28

4. In the Toolspace, Settings tab, expand the Point collection 
until Point Styles displays. Expand the Point Styles collection.

Review the Point Styles 
list and note that there is 
no light pole style. 

5. In the Point Styles list, select the ASC-Guy pole style, 
right-click, and select Copy….

Practice Objective

• Create a point marker and label style to ensure that the correct symbol 
is assigned to specific points.
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6. In the Information tab, change the point style’s name to 
ASC-Light Pole and enter your name or initials in the 
Created by: field.

7. Select the Marker tab. Select the Use AutoCAD BLOCK 
symbol for marker option. In the block list, scroll across as 
required and select the AutoCAD block ST-Light, as shown 
in Figure 2–29.

Figure 2–29

8. Select the Display tab and note that the layer settings are 
from the Guy Pole point style.

9. You can reassign the marker and/or label layer by selecting 
the layer name. Select the layer name to display the drawing 
layer list.
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10.Click New in the top right corner of the Layer Selection dialog 
box. The Create Layer dialog box opens (as shown in 
Figure 2–30), enabling you to create new layers without 
having to use the Layer Manager.

Figure 2–30

11. For the Layer name, type V-NODE-POST, and then set the 
Color to yellow, as shown in Figure 2–30. Click OK to exit 
the Create Layer dialog box. Click OK to exit the Layer 
Selection dialog box.

12.Click OK to create the point style.

13.Review the Point Styles list and note that ASC-Light Pole is 
now a point style, as shown in Figure 2–31.

Figure 2–31

14.Save the drawing.
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Task 2 - Create a point label style’s components.

1. Continue working with the drawing from the previous task or 
open SUV1-B2.dwg.

2. In the Toolspace, Settings tab, expand the Point collection 
until the Point Label Styles list displays.

3. From the list of point label styles, select 
ASC-Point#-Elevation-Description, right-click, and select 
Copy.

4. In the Information tab, change the name to 
ASC-Point#-Description-N-E and enter your name or initials 
in the Created by: field.

5. Select the Layout tab and do the following (as shown in 
Figure 2–32):

• Select Point Number in the Component name drop-down 
list. 

• Set the Anchor Component to <Feature>.

• Set the Anchor Point to Top Right.

• Set the Attachment to Bottom left.

These settings attach 
the bottom left of the 
label to the top right of 
the point object.

Figure 2–32
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Since the elevation label 
is not required, you can 
delete it. 

6. Select Point Elev in the Component name drop-down list 

and click , as shown in Figure 2–33. At the Do you want to 
delete it? prompt, click Yes.

Figure 2–33

7. Select Point Description in the Component name 
drop-down list and do the following (shown in Figure 2–34):

• Set the Anchor Component to Point Number.

• Set the Anchor Point to Bottom Left.

• Set the Attachment to Top Left.

Figure 2–34

You will now add a new 
text component to 
display the Northing and 
Easting. 

8. Expand the Create Text Component flyout (shown in 
Figure 2–35) and select Text to create a text component.

Figure 2–35
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9. Change the default Name text.1 to Coordinates, and then 
do the following:

• Set the Anchor Component to Point Description.

• Set the Anchor Point to Bottom Left.

• Set the Attachment to Top Left.

You will now change the 
contents from the 
default label set by the 
Autodesk Civil 3D 
software to display the 
coordinates.

10.Click  in the Contents cell, next to Label Text, as shown in 
Figure 2–36.

Figure 2–36

11. In the Text Component Editor dialog box, double-click on the 
text in the right side panel to highlight it and type N:.

12.Select Northing in the Properties drop-down list. Change the 

Precision to 0.001 and click , as shown in Figure 2–37, to 
add the code to display the northing.

Figure 2–37
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13.Click at the end of the code. Press <Enter> to insert a new 
line followed by the letter E and a colon. Then select Easting 
in the Properties drop-down list and add it to post the code in 
the right side panel. The following should be displayed:

In the easting, the value 
will be displayed to the 
4th decimal, P4. 
Change it so that it 
matches the northing.

• N:<[Northing(Uft|P3|RN|AP|GC|UN|Sn|OF)]>

• E:<[Easting(Uft|P4|RN|AP|GC|UN|Sn|OF)]>

14.Select all of the code for the easting. Change the Precision to 

0.001 and click  to revise the easting code. 

15.Select the Format tab and verify that Justification is set to 
Left. Click OK to accept the changes in the Text Component 
Editor dialog box, and click OK again to accept the changes 
in the Label Style Composer.

16.Save the drawing.

Task 3 - Apply style components.

1. Continue working with the drawing from the previous task or 
open SUV1-B3.dwg.

Point Groups will be 
covered in detail later in 
this chapter.

2. In the Toolspace, select the Toolspace, Prospector tab and 
expand the Point Groups collection until the StreetLights 
point group displays. Select the StreetLights group, 
right-click, and select Properties.

3. In the Information tab, expand the Point Style drop-down list 
and select ASC-Light Pole. Then expand the Point label 
style drop-down list and select 
ASC-Point#-Description-N-E, as shown in Figure 2–38.

Figure 2–38
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4. Click OK to accept the changes and close the dialog box.

If the symbol and label 
do not change, in the 
Toolspace, Prospector 
tab, right-click on the 
StreetLights point group 
and select Update.

5. The symbols for the Light pole points have now been 
changed. Additionally, both the point symbols and point 
labels are annotative. In the Status Bar, expand the 
Annotation Scale drop-down list and change the scale of the 
drawing from 1"=80' to 1"=40', as shown in Figure 2–39. The 
size of the labels and point symbols change.

Figure 2–39

6. Save the drawing.
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2.5 Point Settings
When creating new points, you must determine the next point 
number, and which elevations and descriptions to assign and 
how to assign them. To set the current point number, default 
elevations, descriptions, and other similar settings, you can use 

the expanded Create Points toolbar. Click  in the Create 
Points toolbar to display the Points Creation and Point Identity 
categories (shown in Figure 2–40), which contain the most 
commonly used values.

Figure 2–40

Points Creation Values

The Points Creation area affects prompting for elevations and/or 
descriptions. The two properties in this area are Prompt For 
Elevations and Prompt For Descriptions. These properties can 
be set as follows:

None Does not prompt for an elevation or description.

Manual Prompts for an elevation or description.

Automatic Uses the Default Elevation or Default Description value 
when creating a point.

Automatic
-Object

Creates points along an alignment whose description 
consists of the Alignment name and Station. This 
description is not dynamic and does not update if the 
alignment changes or the point is moved.
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Point Identity Values

The Point Identity area sets the default method of handling 
duplicate point numbers. If there are duplicate point numbers, 
there are three ways to resolve the duplication: 

1. Overwrite the existing point data.
2. Ignore the new point.
3. Assign it a new number.

This area’s critical property is Next Point Number. It is set to the 
first available number in the point list. If a file of imported point 
data uses point numbers 1-131 and 152-264, the current point 
number is 132 after importing the file. This value should be set 
manually to the next required point number before creating new 
points with the Create Points toolbar. 

You can also change these point settings by selecting the 
Toolspace, Settings tab and expanding the Commands collection 
under the Point collection. Right-click on CreatePoints and 
select Edit Command Settings..., as shown on the left in 
Figure 2–41. In the Edit Command Settings dialog box, you can 
set the defaults for Point Creation, as shown on the right. Note: 
Ideally, this will be preset for you by your BIM Manager, 
according to your organization’s standards.

Figure 2–41
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2.6 Creating Points
You can create points using the commands in the Create Points 
toolbar. These commands include:

• Miscellaneous - Manual: Creates a new point at specified 
coordinates.

• Alignments - Station/Offset: Creates a point at an 
alignment’s specific station and offset. These points and their 
descriptions do not update if the alignment is modified or the 
point is moved. If you prefer a dynamic station and offset 
labels, consider using an Alignment label instead.

• Alignments - Measure Alignment: Creates point objects at 
a set interval, which is useful for construction staking. Again, 
these points do not update if the alignment changes.

• Surface - Random Points: Creates points whose elevation 
is from a specified surface. These points can update, but only 
if you manually force the update. If you prefer a dynamic spot 
label which will always be up to date, consider a Surface 
label instead.

Each icon in the Create Points toolbar has a drop-down list. If 
you expand it, you can select a command from the list to run, as 
shown in Figure 2–42.

Figure 2–42
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Practice 2c Creating Autodesk Civil 3D 
Points

In this practice, a fire hydrant was located by GPS. You will add a 
point object to locate it manually.

1. Continue working with the drawing from the previous practice 
or open SUV1-C.dwg.

2. In the Home tab>Create Ground Data panel, select Points>
Point Creation Tools to display the Create Points toolbar. 

Expand the toolbar by clicking .

3. In the Point Identity area in the dialog box, set the Next Point 

Number to 260 and collapse the toolbar, by clicking .

4. Select the Manual option in the miscellaneous group in the 
toolbar as shown in Figure 2–43.

Figure 2–43

5. When prompted for a location, enter 6256069.30,2036634.25 
and press <Enter>. 

• When prompted for a description, type HYD and press 
<Enter>. 

The period is a 
placeholder for the 
elevation field. Typing 
zero is not correct 
because 0 is a valid 
elevation.

• When prompted for an elevation, press <Enter> to accept 
the default value of <.> (period), because it is unknown. 

• Press <Enter> again to finish the command and select X 
in the Create Points dialog box to close it. 

• In the Transparent Command toolbar, click  (Zoom to 
Point), and type 260.

6. Save the drawing.

Practice Objective

• Create a point manually then zoom to it using transparent commands.
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2.7 Description Key Sets
Description Keys categorize points by their field descriptions 
(raw description). If a point matches a Description Key entry, the 
point is assigned a point and label style, and a full description (a 
translation of the raw description). Description Key Sets can also 
scale and rotate points. 

The Description Key’s first five columns are the commonly used 
entries, as shown in Figure 2–44.

Figure 2–44

• To create a new Description Key row, select an existing code, 
right-click, and select New. To edit a code, double-click in the 
cell.

Code, Point, and Label Style 

Description code is a significant part of data collection. Codes 
assigned to a raw description trigger action by the Description 
Key Set. Each entry in the set represents all of the possible 
descriptions that a field crew would use while surveying a job. 
When a raw description matches a code entry, the Key Set 
assigns all of the row’s values to the matching point, including 
point style, label style, translates the raw description, and 
possibly assigns a layer. Codes are case-sensitive and must 
match the field collector’s entered raw description.
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A code might contain wild cards to match raw descriptions that 
contain numbering or additional material beyond the point’s 
description. For example, MH? would match MH1, MH2, etc.,but 
not MH12, since the ? (question mark) symbol matches only 
single characters, whereas UP* would match UP 2245 14.4Kv 
Verizon, since the * (asterisk) matches any string characters. 
Common wild keys are described as follows:

Matching a Key Set entry for the code assigns a Point Style at 
the point’s coordinates. If the Point Style is set to Default, the 
Settings tab’s Point feature Point Style is used (set in the Edit 
Feature Settings dialog box), as shown in Figure 2–45.

Matching a Key Set entry for the code assigns a point label style 
to annotate important point values. This is usually a number, 
elevation, and description. If the Point Style is set to Default, the 
Settings tab’s Point feature Point Label Style is used (set in the 
Edit Feature Settings dialog box), as shown in Figure 2–45.

Figure 2–45

# (pound) Matches any single numeric digit. (T# matches T1 through 
T9.)

@ (at) Matches any alphabetic character. (1@ matches 1A through 
1Z.)

. (period) Matches any non-alphanumeric character. (T. matches T- or 
T+.)

* (asterisk) Matches any string of characters. (T* matches TREE, 
TR-Aspen, Topo, or Trench.)

? (question 
mark)

Matches any single character. (?BC matches TBC or 3BC.)
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Format

The Format column translates the raw description (what the 
surveyor typed) into a full description (what you want it to read). 
When including spaces in a raw description, the Autodesk Civil 
3D software assigns parameter numbers to each description 
element. Parameters are represented by a $ sign, followed by a 
number. For example, the description PINE 6 has two elements: 
PINE and 6, with PINE as parameter 0 ($0) and 6 as parameter 1 
($1). When the Format column contains $*, it indicates that the 
software should use the raw description as the full description. 
The Format column can reorder the parameters and add 
characters to create a full description. For example, the raw 
description PINE 6 can be translated to 6' PINE by entering 
$1' $0.

A complex raw description is as follows:

TREE D MAPLE 9

For the raw description to match the Description Key Set entry, 
the entry TREE must have an asterisk (*) after TREE (as shown 
in Figure 2–46). The raw description elements and their 
parameters are TREE ($0), D ($1), MAPLE ($2), and 9 ($3). The 
Format column entry of $3' $2 $0 creates a full description of 9' 
MAPLE TREE.

Figure 2–46

If a point does not 
match any Description 
Key Set entry, it 
receives the default 
styles assigned by the 
_All Points group.

The Layer column assigns a layer to the matching point. If the 
Point Style already has a marker and label layer, this entry 
should be toggled off. The Description Key Set also contains the 
Scale and Rotate Parameter columns. In the example in 
Figure 2–46, the 3 for the trunk diameter can also be a tree 
symbol scaling factor when applied to the symbol’s X-Y.

The most common parameter is the Scale parameter. With this 
parameter, a surveyor will enter the size of a tree as part of the 
description and the description key file will insert a symbol scaled 
to the value provided by the surveyor. 

 m
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The Rotate parameter is used less frequently, but it can be 
useful. For example, you can edit the point file in the office (not in 
the field) once you have determined the bearing of a roadside 
curb. Then, you can append that rotation value as a parameter to 
the description of each hydrant, street sign, light standard, etc. 
along the road to have them inserted with the proper rotation so 
the symbols will be inserted with the proper angle to be 
perpendicular to the curb.
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Practice 2d Creating a Description Key Set

In this practice, you will learn to create a new Description Key 
Set entry and apply it to an existing point. In addition, you will 
update the Description Key Set to use parameters.

Task 1 - Create a new Description Key Set entry.

1. Continue working with the drawing from the previous 
practice, or open SUV1-D.dwg.

2. In the Toolspace, Settings tab, expand the Point collection 
until the Description Key Set collection and its list display.

3. Select Civil 3D, right-click, and select Edit Keys…

4. Right-click in any Code cell and select New…, as shown in 
Figure 2–47.

Figure 2–47

5. Double-click in the Code cell in the newly created row and 
type HYD, as shown in Figure 2–48.

Figure 2–48

Practice Objective

• Assign point symbols, labels, layers, etc., on import by setting up 
Description Key Sets.
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6. In the Style cell, toggle on the Point Style and select the Style 
cell to open the Point Style dialog box, as shown in 
Figure 2–49. Select ASC-Hydrant (existing) in the 
drop-down list and click OK to assign the style to the code.

Figure 2–49

7. Leave <default> selected as the Point Label Style and $* as 
the Format. This means the label will be the same as the one 
entered by the surveyor. 

8. Leave the check box toggled off in the Layer column.

You do not have a scale 
parameter and will not 
be using a fixed scale.

9. Select the Yes option in the Use drawing scale column, and 
clear the check box for the Scale Parameter, as shown in 
Figure 2–50.

Figure 2–50

10.Close the DescKey Editor vista by clicking  in the top right 
corner of the palette.

Task 2 - Apply the new Description Key Set to an existing 
point.

1. If not already zoomed into the new point, in the Transparent 

tab, click  (Zoom to Point), and then type 260.
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2. In the Toolspace, Prospector tab, select the _All Points 
group, right-click, and select Apply Description Keys, as 
shown in Figure 2–51.

The point updates to 
display the Hydrant 
symbol and its new 
description.

Figure 2–51

3. Save the drawing.

Task 3 - Update the Description Key Set to use parameters.

In this task, you will use the Parameters feature to control the 
display properties of symbols in your drawings.

In this case, you will use the Rotate parameter, so that the 
pumpers on the hydrant display correctly (i.e., running parallel to 
the road).

1. In the Toolspace, Settings tab, expand Point>Description Key 
Sets. Select Civil 3D, right-click, and select Edit Keys…, as 
shown in Figure 2–52.

Figure 2–52

2. In the HYD row, Code column, type HYD*. The asterisk 
symbolizes a wildcard, (i.e., any character after the letters 
HYD).
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3. In the HYD row, select the check box in the Marker Rotate 
column (as shown in Figure 2–53), select the cell, and then 
select Parameter1 in the drop-down list.

Figure 2–53

4. Click  in the top right corner of the dialog box to close the 
Panorama view.

5. Using the AutoCAD Distance inquiry, you will note that the 
bearing of the curb is 5 degrees clockwise, as shown in 
Figure 2–54.

Figure 2–54

6. In Model Space, select the Hydrant point object, right-click, 
and select Edit Points. 

The -5 indicates the 
required rotation.

7. Set the Raw Description from HYD to HYD -5. Ensure that 
you put a space after HYD.

8. Select the row, right-click, and select Apply Description 
Keys, as shown in Figure 2–55.

Figure 2–55
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9. Click  in the top right corner of the dialog box to close the 
Panorama view.

The hydrant has now been rotated to display the hydrant 
pumpers following the bearing of the curb, as shown in 
Figure 2–56. 

The curb line is 
accentuated in the 
figure for clarity. The 
rotation is slight and 
may be difficult to 
discern.

Figure 2–56

10.The label also displays the rotation angle text -5, which you 
do not want. In the Toolspace, Settings tab, expand the Point 
and Description Key Sets collections. Select Civil 3D, 
right-click, and select Edit Keys…

11. In the HYD row, change the Format from $* to Hydrant, as 
shown in Figure 2–57.

Figure 2–57

12.Click  in the top right corner of the dialog box to close the 
Panorama view.

13. In Model Space, select the Hydrant point object, right-click, 
and select Apply Description Keys. The changes are now 
applied, as shown in Figure 2–58.

Figure 2–58

14.Save the drawing.



Autodesk Civil 3D 2022: Fundamentals

2–46 © 2021, ASCENT - Center for Technical Knowledge®

2.8 Importing Survey Data
The Autodesk Civil 3D software has methods to import point data 
from ASCII text files to Autodesk LandXML files, as well as 
methods to convert AutoCAD points to Autodesk Civil 3D points. 
The Toolspace, Survey tab also inserts points from a survey to a 
drawing.

Import Points
Only

There are two methods of launching the import point feature, one 
is by using the Insert tab and the other is using the Points 
creation tool in the Home tab, Create Ground Data panel or the 
Toolspace, Prospector tab.

How To: Use the Insert Tab Method

Alternatively, you can 

click  (Import Points) 
in the Create Points 
toolbar.

1. In the Insert tab, click  (Points from File).This opens the 
Import Points dialog box.

2. In the Import Points dialog box, set the file format, select the 
files to import, set any advanced options, and click OK to 
import the points.

How To: Use the Point Creation Tools Method

1. Open the Create Points dialog box by expanding Points in the 
Home tab, expanding the drop-down list and selecting a 
Create Points option, as shown on the left in Figure 2–59. 
Alternatively, in the Toolspace, Prospector tab, select Points, 
right-click and select Create…, as shown on the right.

Figure 2–59
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All commands in the Points drop-down list can also be 
accessed in the Create Points toolbar, as shown in 
Figure 2–60.

Figure 2–60

2. Click  (Import Points) to open the Import Points dialog box 
(shown in Figure 2–61). 

Figure 2–61

3. In the Import Points dialog box, under the Specify point file 
format area, select the required format. 

4. After setting the format, click  on the right to open the 
Select Source File dialog box. 

You can select multiple 
files if they have the 
same file format.

5. In the Select Source File dialog box, browse to the import 
point file, select it, and select Open. Assign the imported 
points to a new or existing point group by selecting the Add 
Points to Point Group option and selecting the point group 
in the drop-down list. Select Advanced options as required.
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Duplicate Point
Numbers

If an imported file creates duplicate point numbers, the Autodesk 
Civil 3D software overwrites, merges, or reassigns them during 
the import process. When encountering duplicate point numbers, 
the Autodesk Civil 3D software can assign the next available 
number, add an offset value (add 5000 to each point number that 
conflicts), overwrite points (replaces the current point values with 
the file’s values), or merge points (add the file’s values to an 
existing point’s values). If using the offset method, the new point 
numbers are kept unique in the drawing. If using the next 
available number method, the new points blend into the original 
points and are difficult to identify.

The offset method is preferred when resolving duplicate point 
numbers. When importing points that will potentially duplicate 
point numbers, the Create Points toolbar’s Point Identity 
settings, as shown in Figure 2–62, is the default when handling 
duplicate point numbers.

Figure 2–62

In the Point Identity settings, set the duplicate point resolution 
method for the If Point Numbers Already Exist variable. The four 
methods are Renumber, Merge, Overwrite, and Notify, as 
shown in Figure 2–63. The import process never overwrites point 
data unless you specify that it should do so. 

Figure 2–63
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When encountering a duplicate point, the Duplicate Point 
Number dialog box opens. After you define a resolution, it can be 
assigned to the current duplicate point or to all encountered 
duplicate points. 

Survey
Toolspace

The Toolspace, Survey tab displays a panel through which all 
surveys are processed. Survey uses graphics to display field 
book imports, figure and network previews, and points. If you 
toggle off these graphics, you can process a survey without a 
drawing being open. If you want to display these graphics, you 
need to have a drawing open. Survey prompts you to open a 
drawing if you do not have one open.

The Toolspace, Survey tab contains Survey settings, Equipment 
defaults, Figure Prefixes, and Linework Code Sets. Survey’s 
settings can be on a local or network folder. It is preferred to use 
a network folder in larger offices because all users can then 
standardize the file values.

How To: Display the Toolspace, Survey Tab

If your Toolspace does not display the Survey tab, click 

(Survey) in the Home tab>Palettes panel, as shown in 
Figure 2–64.

Figure 2–64

Import Points
and Figures

Using the
Survey

Database

After collecting and coding the data, and then downloading and 
converting it, the next step in Survey is to import the survey data, 
review it, and place the survey points and figures into a drawing. 
A working folder defines where the local Survey Database is 
located. The preferred location is a network folder, in which you 
place the local Survey Databases. The Survey User Settings 
dialog box sets the defaults for all new Survey Databases. You 
should set these before starting Survey. The Survey Working 
Folder is the location for all of the Survey Databases and can be 
local or on the network. The default working folder is 
C:\Users\Public\Documents\Autodesk\Civil 3D Projects.



Autodesk Civil 3D 2022: Fundamentals

2–50 © 2021, ASCENT - Center for Technical Knowledge®

How To: Set the Working Folder for the Survey 
Database

1. In the Toolspace, Survey tab, select Survey Databases.
2. Right-click and select Set working folder…, as shown in 

Figure 2–65. 

Figure 2–65

Survey Database

Survey Database 
Folders cannot be 
deleted in Autodesk 
Civil 3D Survey. If you 
want to delete the 
working folder, this 
process must be done 
through the Windows 
File Explorer, external to 
the Autodesk Civil 3D 
software.

A Survey Database is a subfolder in the working folder. The 
Survey Working Folder contains the Survey’s settings and 
observation database. This database contains the Survey’s 
Networks, Figures, and Survey Points.

To import a field book, you use the Survey’s Import Events 
collection. Import Events provides access to an Import wizard, 
which guides you through the steps of importing a file. 

1. To open the Import wizard, select Import Events in the 
Survey, right-click, and select Import survey data….

2. The Specify Database page is shown in Figure 2–66. It sets 
the survey, creates a new survey, and edits the Survey’s 
settings.



Survey, Points, and Linework

© 2021, ASCENT - Center for Technical Knowledge® 2–51

Figure 2–66

3. Click Next. The Specify Data Source page (shown in 
Figure 2–67), defines the file import type, the file’s path, and 
its format (if it is a coordinate file).

Figure 2–67
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4. Click Next. The Specify Network page (shown in 
Figure 2–68) enables you to change the network or create a 
new one. If importing a Field Book, a Network must be 
assigned. If Importing a Point File, a Network is optional.

Figure 2–68

5. Click Next. 

6. The Import Options page (shown in Figure 2–69) sets the 
values for the import. These settings affect what the import 
does and which support files it uses.

Figure 2–69
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If the field book has figure coding from a conversion, you do not 
need to toggle on the Process linework during import property. 
This is for Point files other than field books that have Linework 
Code Set commands included in the point’s description.

Inserting figures requires entries to be in the Figure Prefix 
database and figure styles to be in the drawing. This is required 
to point the figure and linework to the correct drawing layers and 
to specify whether the figure is also a breakline in a surface.

When inserting points, it is necessary to have a Description Key 
Set defined to assign points, point label styles, and layers, and to 
translate raw descriptions to full descriptions.

Open a Survey Database for Editing

Only one Survey Database can be edited at a time. When 
opened for editing, this prepares the survey for reading and 
writing. There are options to set the path or location for the 
Survey Database project files, and for all of the settings. When 
you create a new Survey Database, a Windows folder is created 
with the same name. If you close a drawing with a survey open, 
the Survey Database closes automatically. You must start a new 
drawing or open an existing drawing and then open the required 
Survey Database. You can only have one Survey Database open 
at a time.

How To: Open a Survey Database 

1. In the Toolspace, Survey tab, expand the Survey Database 
collection.

2. Select the survey database that you want to open, right-click, 
and select Open for edit or Open for read-only, depending 
on your requirements, as shown in Figure 2–70. Contrary to 
most Civil 3D functions, where double-clicking invokes an 
edit function, double-clicking on a Survey Database will open 
it as read-only.

Figure 2–70
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Hint: Survey Database Migration to 2020 and Above

The Survey Database format has changed in the 2020 
Release. If you have existing Survey Databases created in an 
earlier format, they will be marked and must be migrated, 
Right-click on the Survey Database and pick Migrate....You will 
need to select a new location for the updated Survey 
Database, as shown in Figure 2–71.

Figure 2–71
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Practice 2e Importing Survey Data

In this practice, you will import an ASCII file created in the field. 

1. Continue working with the drawing from the previous practice 
or open SUV1-E.dwg from the C:\Civil 3D Projects\
Working\Survey folder. 

2. On the Survey tab, right-click on Survey Databases and 
select Set working folder, as shown in Figure 2–72.

Figure 2–72

3. Browse to C:\Civil 3D Projects\Survey Databases and click 
the Select Folder button in the lower right corner.

4. In the Home tab>expanded Create Ground Data panel, click 

(Import Survey Data).

5. On the Specify Database page, click Create New Survey 
Database..., as shown in Figure 2–73.

Figure 2–73

Practice Objective

• Import points from an ASCII file created from the field survey.
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6. Type ASCENT-Fund for the name and click OK.

7. Click Edit Survey Database Settings... as shown in 
Figure 2–74.

Figure 2–74

8. Under Units in the Survey Database Settings dialog box, for 
the Coordinate Zone, click the Browse icon. In the Select 
Coordinate Zone dialog box, select NSRS 2007 California 
State Planes, Zone VI, US Foot (as shown in Figure 2–75). 
Click OK twice and then click Next.

Figure 2–75
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9. On the Specify Data Sources page, do the following, as 
shown in Figure 2–76: 

• Expand the Data source type drop-down list and select 
Point File.

• Click  (Add file) and browse to C:\Civil 3D 
Projects\Survey Databases\Data. Select Field Survey.txt 
and open it. 

• For the file format, select PNEZD (comma delimited). 

• Click Next.

Figure 2–76

10.On the Survey Network page, click Next.
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11. On the Import Options page, select Process linework 
during import, Insert figure objects, and Insert survey 
points, as shown in Figure 2–77. Click Finish.

Figure 2–77

12.Save the drawing.
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2.9 Reviewing and Editing Points
Reviewing and editing point data occurs throughout the 
Autodesk Civil 3D environment. It is as simple as selecting a 
point in the drawing, right-clicking, and selecting Edit Points…. 
You can also edit points using the shortcut menu in the Points 
heading in the Toolspace, Prospector tab. Alternatively, you can 
select a point entry in the Toolspace, Prospector’s preview area.

Repositioning Point Labels

Each point label style has Dragged State parameters. These 
parameters affect the label’s behavior when moving the label 
from its original label position. Depending on the Dragged State 
parameters, a label can change completely (Stacked text) or 
display as it was originally defined (As composed). An example 
of a label is shown in Figure 2–78.

When selecting a point, 
it displays multiple grips. 
Click the move grip 
when you want to 
relocate the label.

Figure 2–78
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A point displays three grips when selected. Use the Rectangle 
label grip to Move, Rotate, and Toggle sub item grips and Reset 
the label. Use the Diamond point object grip to Move and Rotate 
both the label and marker, Rotate just the marker, reset marker 
rotation, and Reset all. The third grip is a plus symbol that 
enables you to add vertices to the leader, as shown in 
Figure 2–79.

Figure 2–79

• Each label component can be modified and the change is 
only for that point.

• Point objects can be set to automatically rotate to match the 
current view using style settings. If this is not preferred, they 
can have a rotation assigned directly through the AutoCAD 
Properties dialog box.

• You can reset a label to its original position by selecting the 
point, right-clicking, and selecting Reset Label.



Survey, Points, and Linework

© 2021, ASCENT - Center for Technical Knowledge® 2–61

2.10 Point Reports
The surveyor needs to produce point reports. These can include 
a record list for the project, a checklist to find errors, reference 
for field crews, stakeout, etc. Incorporating survey data with an 
Autodesk Civil 3D engineering project is unique in that it relies on 
connection and communication with third party survey 
equipment and software. Autodesk has collaborated with the 
major survey equipment vendors (TDS Survey Link, TOPCON 
Link, Trimble Link, Carlson Connect, and Leica X-Change) and 
they have developed applications that interface their equipment 
with the Autodesk Civil 3D software.

Autodesk Civil 3D points can be exported and then uploaded to 
the survey equipment without relying on manually created lists. 
However, a documented point list might be required. There are 
several ways to create reports about points.

Point Reports - Reports Manager

The Autodesk Civil 3D Reports Manager produces several 
point reports. To create reports from the Reports Manager, 
the Toolspace, Toolbox tab must be available. To display the 
Toolspace, Toolbox tab, go to the Home tab>Palettes panel, and 
select Toolbox. Then select the Toolspace, Toolbox tab and 
expand the Reports Manager collection to display a list of object 
type reports, as shown in Figure 2–80.

Figure 2–80
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Points are easily organized into a convenient, legible list that 
displays the point number, northing, easting, elevation, and 
description (as shown in Figure 2–81). Another point report lists 
the points’ station and offset values relative to an alignment. 
Another report calculates distances and angles from an occupied 
and a backsight. You can transfer points to Microsoft Excel 
spreadsheets using a CSV report. To create these reports, select 
the report’s name, right-click, and select Execute….

Figure 2–81

Point Editor Reports

Another report method is to use the Point Editor vista. In the 
Toolspace, Prospector tab, select Points, right-click, and select 
Edit… to display the Point Editor vista, as shown in Figure 2–82. 

Figure 2–82

In the vista, you can select individual points using <Ctrl> or 
select blocks of points using <Shift>. When done selecting 
points, right-click and select Copy to clipboard. You can then 
paste the copied points into Microsoft Excel, Notepad, or any 
application that accepts the points, as shown in Figure 2–83.

Figure 2–83
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Practice 2f Manipulating Points and Point 
Reports

Task 1 - Modify the position of the labels.

1. Continue working with the drawing from the previous practice 
or open SUV1-F.dwg.

This positions the point 
at the center of the 
screen.

2. In the preview point list, scroll down until the point number 
260 displays. Select it, right-click, and select Zoom to, as 
shown in Figure 2–84.

Figure 2–84

3. In a typical drafting workflow, points can overlap, making 
them illegible. Since the Point Style’s text height is a function 
of the drawing scale, changing the Annotation Scale changes 
the text size. If need be, on the Status Bar, set the Annotation 
Scale to 1"=40', as shown in Figure 2–85, to change the 
point size in the drawing.

Figure 2–85

Practice Objectives

• Modify the label position for points to ensure that the plan is readable.

• Share information about points used for error checking or staking out 
points using predefined reports.
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4. Select point 260 to display its grips. Select the Drag Label 
grip, as shown in Figure 2–86, to relocate the label. 

Figure 2–86

5. With the label still displaying grips, hover on the Rectangle 
grip and select Reset Label.

6. With the label still displaying grips, hover over the Square 
label grip to display the options for moving, rotating, and 
additional sub item grips, as shown in Figure 2–87. Select 
Rotate label and rotate the label. Type 45 to rotate the label 
45 degrees counter-clockwise.

Figure 2–87
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7. With the label still displaying grips, hover over the diamond 
point grip to display the options to move, rotate label and 
marker, and Rotate marker, as shown in Figure 2–88. Select 
Rotate marker and rotate the marker. Type 45 to rotate the 
marker 45 degrees counter-clockwise.

Figure 2–88

8. With the label still displaying grips, hover over the diamond 
point grip again and select Reset all, as shown in 
Figure 2–89. 

Figure 2–89

9. Save the drawing.
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Task 2 - Create point reports.

1. If the Toolspace, Toolbox tab is not displayed in the 

Toolspace, select the Home tab and click  (Toolbox), to 
display the Toolspace, Toolbox tab.

2. Select the Toolspace, Toolbox tab and expand the Reports 
Manager collection to display the list of object type reports. 
Expand the Points collection, as shown in Figure 2–90.

Figure 2–90

3. Select Point List, right-click, and select Execute. 

4. In the Export to LandXML dialog box, click OK to generate 
the report. In the Save As dialog box, browse to the C:\Civil 
3D Projects\Documents\Reports folder and type  <Your 
Initials>-Points.html, and save the file.

5. The point list displays in Internet Explorer. Review the report 
and when done, close it.

6. Save the drawing
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2.11 Point Groups
Point groups organize points that share common descriptions 
and characteristics (such as existing storm, gas lines, building 
corners, etc.). If you consider the points in the project to be a 
database, then Point Groups can be considered a means of 
querying the point database. 

Point groups also enable points to display different point or label 
styles. For example, a Landscape Architect needs to display 
different symbols for each tree species, while an Engineer only 
needs to display a generic tree symbol. The Description Key Set 
enables you to assign the tree species symbols for the 
Landscape Architect, and a point group enables generic tree 
symbols to override the symbols for the Engineer. Another 
function of a point group is to hide all of the points. 

In the Autodesk Civil 3D software, point groups can be defined in 
the template along with a Description Key Set. When you create 
a new drawing from this template and import points, they are 
assigned their symbols and can be sorted into point groups.

All points in a drawing belong to the _All Points point group. 
Consider this point group as the point database. It cannot be 
deleted and initially is not in a drawing until you add points. All 
new point groups include all drawing points or a subset of 
drawing points (referenced points from the _All Points point 
group).

Defining Point
Groups

To create a new point group, select the Toolspace, Prospector 
tab, right-click on the Point Groups collection and select New…. 
Alternatively, in the Home tab, expand Points and select Create 
Point Group.

When you select New… or Create Point Group, the Point 
Group Properties dialog box opens. It has nine tabs, each 
affecting the point group’s definition.

The Point Groups, Raw Desc Matching, Include, and Query 
Builder tabs add points to the point group. The Exclude tab 
removes points from a point group.
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The Information tab defines the point group’s name. The Point 
style and Point label style should remain at their defaults, unless 
you want to use either style to override the assigned styles of the 
points in the point group. The points in the point group display 
their originally assigned styles until you toggle on the override. A 
point group can be locked by toggling on the Object locked 
option to prevent any changes to the group. The Point Group 
Properties dialog box is shown in Figure 2–91.

Figure 2–91

The Point Groups tab lists the drawing’s groups. A point group 
can be created from other point groups, thereby creating a 
hierarchy of Point Groups. When you select a point group name, 
the group and its points become members of the new point 
group. For example, the point group Trees is created from the 
point groups Maple, Walnut, Oak, etc.

The Raw Desc Matching tab lists codes from the Description Key 
Code set. When you toggle on the code, any point matching the 
code becomes part of the point group.

If you cannot select a point with the previous two methods, the 
Include tab enables you to include points by specifically entering 
in the selection criteria. The criteria include the point number 
(point number list or by selection), elevation, name, raw 
description, full description, and all points.
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• With numbers matching: Selects points by a point number 
range or list. When creating a list, sequential point numbers 
are hyphenated (1-20) and individual numbers are in a 
comma delimited list. A point list can include sequential and 
individual points (1-20, 14, 44, 50-60). Select Selection Set 
in Drawing to select the points in the drawing and list their 
point numbers at the top of the Include tab.If using the 
Selection Set in Drawing method, keep in mind that a Point 
Group defined by exact numbers will not be dynamic since it 
is fixed on individual point numbers.

• With elevations matching: Enables you to select points by 
entering a specific elevation or by specifying a minimum 
and/or maximum elevation. For example, valid entries include 
>100,<400, and >100. The first entry only includes points 
whose elevation is above 100, but less than 400. The second 
entry only includes points whose elevation is greater than 
100. A point without an elevation cannot be selected using 
this method. An elevation range, defined by separating the 
start and end numbers with a hyphen, includes points whose 
elevation falls in the range (1-100). This can be combined 
with greater or less than symbols.

• With names matching: Selects points based on matching 
their point names. Enter one or more point names separated 
by commas.

• With raw/full descriptions matching: Selects points based 
on matching an entered raw or full description. Enter one or 
more descriptions separated by commas. You can use the 
same wildcards as the Description Key Set. Generally, this 
method uses the asterisk (*) as the wildcard after the 
description (e.g., PINE*, CTV*, CL*, etc.). By default, this is 
not case-sensitive.

• Include all points: Assigns all points in the drawing to the 
point group. When this option is toggled on, all other Include 
options are disabled. 

The Exclude tab has the same options as the Include tab, except 
for the Include All Points option.

The Query Builder tab creates one or more expressions to select 
points. Each query is a row selecting points. As with all SQL 
queries, you combine expressions using the operators AND, OR, 
and NOT. You can also use parentheses to group expressions. It 
is here where you can make the criteria case-sensitive.
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The Overrides tab overrides the points in the point group’s raw 
description, elevation, point style, and/or point label style. For 
example, you can override specific tree species symbols with a 
generic tree symbol, override a label style when displaying this 
group, or override the point and label style with none (to hide all 
points).

The point group display order affects points and their overrides. 
To change how the point groups display, modify the Point Group 
display order.

The Point List tab displays the point group’s points. This tab 
enables you to review points that are currently in the point group.

The Summary tab displays the point group’s settings. You can 
print this tab as a report by cutting and pasting it into a 
document.

Updating Out-of-Date Point Groups

After defining point groups and adding points to a drawing, the 
group becomes out of date before assigning the points to the 

group. The point group will have an Alert symbol ( ) next to it 
for easy recognition in the Prospector, as shown in Figure 2–92.

Figure 2–92

This enables you to verify that the point(s) should become part of 
the group. To review why a group is out of date, select the group, 
right-click, and select Show Changes… If the changes are 
correct, select Update to add the points to the group. If you know 
that all of the groups displaying as out of date should be 
updated, right-click on the Point Groups collection and select 
Update. At this level, the command updates all of the point 
groups.
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Unlike other Civil 3D objects (such as Surfaces and Corridors), 
you cannot set Point Groups to be Rebuilt Automatically. 

Overriding Point Group Properties

When working with points, you might want them to display 
different labels, not be displayed, or display different symbols. 
Each required change is a function of a point group override. A 
point group that contains all of the points and overrides their 
symbols and labels with none does not display any points. This 
is similar to freezing all of the layers involved with points. A point 
group that changes the symbols that a group displays overrides 
the label styles assigned to the point in the point group. To 
display a different symbol, the point group overrides the 
assigned point styles. To set the style and override the assigned 
styles, toggle on the point group in the Overrides tab and set the 
styles in the Override column of the point group, as shown in 
Figure 2–93.

Figure 2–93

Point Groups Display Properties

When creating a point group, it is placed at the top of the point 
group list. The point group list is more than a list of point groups; 
it is also the Autodesk Civil 3D’s point draw order. The Autodesk 
Civil 3D software draws the point groups starting from the bottom 
of the list to the top. If _All Points is the first drawn point group 
and the remaining point groups are subsets of all points, the 
individual point group does not display, but all of the points 
display.

To display point groups that are a subset of all points, you must 
create a point group whose purpose is to hide all points. This 
popular point group is commonly called No Display. With this 
group, any point group drawn after it displays its members 
without seeing the other points. 
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The Autodesk Civil 3D software draws point groups from the 
bottom to the top of the list. To manipulate the display order, 
right-click on the Point Groups collection in the Toolspace, 
Prospector tab and select Properties. The Point Groups dialog 
box opens, enabling you to modify the point group display order 
using the arrows on the right, as shown in Figure 2–94.

Figure 2–94

These arrows enable you to select the required point group and 
move it up or down in the list (or all of the way to the top or 

bottom of the list with one click, / ) in the hierarchy for 
display purposes. The Point Groups dialog box has two 
additional icons at the top. The first icon displays the changes 
that need to occur in the point groups and the second icon 
updates them.

If you use Description Key Sets, a point displays the assigned 
point and label style when it is part of any point group. The only 
time the point displays another style is when you override the 
style (in the Point Group Properties dialog box, in the Overrides 
tab).
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With the Description Key Set and display order shown in 
Figure 2–95, the points display their originally assigned point 
label styles.

Figure 2–95

The No Display point group includes all of the points, but 
overrides the originally assigned point style and point label styles 
with <none>. When No Display is moved to the list’s top, no 
points display. The Point Groups dialog box is shown in 
Figure 2–96.

Figure 2–96
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Practice 2g Creating Point Groups

In this practice, you will create point groups.

Task 1 - Create point groups (Boundary Pin Survey).

1. Continue working with the drawing from the previous practice 
or open SUV1-FG.dwg.

2. In the Toolspace, Prospector tab, select Point Groups, 
right-click, and select New…, as shown in Figure 2–97.

Figure 2–97

3. In the Point Group Properties dialog box, in the Information 
tab, type Boundary Pin Survey in the Name field, set the 
Point style to ASC-Iron Pin, and set the Point label style to 
ASC-Elevation and Description, as shown in Figure 2–98.

Figure 2–98

Practice Objective

• Create point groups and control the visibility of the points within the 
groups.
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This will also select 
other Iron Pin 
descriptions beyond the 
“Found” ones, which the 
surveyor may use to 
determine Iron Pins.

4. Select the Include tab. Select the With raw description 
matching option. Type *IP. in the field to select all of the 
points that have the last three characters IP. (iron pin). (Verify 
that a period follows IP. By default, this is NOT case 
sensitive.) You can confirm this in the Point List tab, as shown 
in Figure 2–99.

Figure 2–99

5. Click OK to close the dialog box and apply the changes.

Task 2 - Create point groups (No display).

Continue working with the drawing from the previous task. In this 
task, you will use the point group to control the points display. 
Not only will you be able to display the same point differently, but 
you will also be able to control the visibility of the points. This 
eliminates needing to use the Layer command to thaw and 
freeze layers.

1. In the View tab>Named Views panel, select the preset view 
Suv Main.

2. As in Task 1, select Point Groups, right-click, and select 
New… to create a new point group. In the Information tab, 
type No display for the Name.

3. Select <none> for both the Point style and the Point label 
style, as shown in Figure 2–100.

Figure 2–100
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4. Select the Include tab, select Include all points to set it to 
True. Select the Point List tab to confirm that all of the points 
have been included.

5. Select the Overrides tab and select Style and Point Label 
Style, as shown in Figure 2–101.

Figure 2–101

6. Click OK to create the point group. Note that the points have 
disappeared.

7. To control the hierarchy and the display of the point group 
style, select the Toolspace, Prospector tab, select Point 
Groups, right-click, and select Properties.

8. In the Point Groups dialog box, select the Boundary Pin 
Survey point group and move it to the top of the list by 

clicking , as shown in Figure 2–102.

Figure 2–102

9. Click OK to apply the changes. Only the points in the 
Boundary Pin point group display. If the property pins are not 
displayed you might need to regen the drawing (type RE, and 
press <Enter).

10.Experiment with moving point groups up and down the list to 
control the display of points.

11. Save the drawing.
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2.12 Lines and Curves
A typical land development project commences with plotting out 
the property being subdivided, based on the legal description. 
Planners need to enter lines and curves representing the 
property boundaries into the computer from legal text 
description. The Autodesk Civil 3D software makes this task 
easy with the many options under the Lines and Curves 
commands in the Home tab>Draw panel. Expanding the Lines or 
Curves commands displays several options that are not found in 
the ordinary AutoCAD® software, as shown in Figure 2–103.

Figure 2–103

A second option is to use transparent commands. These are 
similar to Object Snaps in that they are only accessible while in 
another command that is searching for a point. 
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Once the required command has been started, you can select 
the transparent commands as follows:

• From the Transparent Command toolbar

• From the Transparent Command ribbon tab

• By typing an apostrophe letter combination in the 
Command Line

• From the right-click menu>Transparent Commands

Icon Command 
Line

Description

’AD Angle Distance: Specifies a point location at an 
angle and distance from a known point and 
direction.

’BD Bearing Distance: Specifies a point location at 
a bearing and distance from a known point (or 
the last point occupied).

’ZD Azimuth Distance: Specifies a point location at 
an azimuth and distance from a known point (or 
the last point occupied).

’DD Deflection Distance: Specifies a point location 
at an angle and distance from a known point and 
previous direction.

’NE Northing Easting: Specifies a point location 
using northing and easting coordinates.

’GN Grid Northing Grid Easting: Specifies a point 
location using a grid northing and grid easting. 
(Note: You must have the drawing zone, 
coordinate system and transformations set for 
grids.)

’LL Latitude Longitude: Specifies a point location 
using latitude and longitude. (Note: You must 
have the drawing zone, coordinate system, and 
transformations set.)

’PN Point Number: Specifies a point location using 
a point number found in the drawing or active 
project.

’PA Point Name: Specifies a point location using a 
point name found in the drawing or active 
project.

’PO Point Object: Specifies a point location by 
picking any part of an existing COGO point in the 
drawing.
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’ZTP Zoom to Point: Zooms to a point in the drawing 
or active project by specifying the point number 
or name.

’SS Side Shot: Specifies a point location at an angle 
and distance from a known point and direction 
(uses the last two entered points to set the 
reference line).

’SO Station Offset: Specifies a point location at a 
station and an offset from an alignment in the 
current drawing.

.g Point Object Filter: Specifies a point location by 
picking any part of an existing COGO point in the 
drawing.

’STAE Profile Station from Plan: Specifies a profile 
view point location by specifying an alignment 
station in plan and an elevation.

’SSE Profile Station and Elevation from Plan: 
Specifies a profile view point location by 
specifying a surface, an alignment station, and a 
point in plan view.

’SPE Profile Station and Elevation from COGO 
Point: Specifies a profile view point location by 
specifying a COGO point and an alignment 
station in plan view.

’PSE Profile Station Elevation: Specifies a profile 
view point location by specifying a station and an 
elevation.

’PGS Profile Grade Station: Specifies a profile view 
point location using grade and station values 
from a known point.

’PGE Profile Grade Elevation: Specifies a profile 
view point location using grade and elevation 
values from a known point.

’PGL Profile Grade Length: Specifies a profile view 
point location using grade and length values 
from a known point (or the last point occupied).

’MR Match Radius: Specifies a radius equal to that 
of an existing object.

’ML Match Length: Specifies a length equal to that 
of an existing object.

’CCALC Curve Calculator: Calculates curve parameters 
based on input.
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The benefit to using these transparent commands to draw 
parcels over the Lines and Curves options (shown previously in 
Figure 2–103) is that a Polyline command can be used to create 
one entity rather than many individual lines that would need to be 
joined later.



Survey, Points, and Linework

© 2021, ASCENT - Center for Technical Knowledge® 2–81

Practice 2h Beginning a Subdivision Project

In this practice, you will use the following legal description below 
to draw a parcel. Later, you will create a parcel from the linework.

From the POINT OF BEGINNING; thence, S 00° 26' 42.2" 
W for a distance of 922.4138 feet to a point on a line. 
Thence, S 00° 24' 20.8" W for a distance of 508.3493 feet to 
a point on a line. Thence, S 66° 03' 35.8" W for a distance of 
92.1845 feet to the beginning of a curve. 

Said curve turning to the right through 42° 35' 49.2", having 
a radius of 627.1788 feet, and whose long chord bears S 
87° 21' 30.4" W for a distance of 455.6165 feet to the 
beginning of another curve. 

Said curve turning to the left through an angle of 19° 13' 
40.4", having a radius of 154.4828 feet, and whose long 
chord bears N 80° 57' 25.2" W for a distance of 51.6000 
feet. 

Thence, S 89° 25' 44.6" W for a distance of 724.9442 feet to 
a point on a line. Thence, N 00° 11' 09.9" E for a distance of 
1904.2647 feet to a point on a line. Thence, S 61° 50' 15.3" 
E for a distance of 135.9034 feet to a point on a line. 
Thence, S 64° 05' 35.8" E for a distance of 77.8201 feet to a 
point on a line. Thence, S 78° 09' 29.2" E for a distance of 
63.8821 feet to a point on a line. Thence, S 66° 23' 19.5" E 
for a distance of 379.2248 feet to a point on a line. Thence, 
S 66° 17' 17.4" E for a distance of 278.5122 feet to a point 
on a line. Thence S 84° 58' 37.7" E a distance of 466.8116 
feet to the POINT OF BEGINNING.

1. Continue working on the drawing from the previous practice 
or open SUV1-H-Survey-.dwg from the C:\Civil 3D 
Projects\Working\Survey folder.

Practice Objective

• Draw a parcel from a legal description.
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2. In effect, you will be tracing over the green perimeter in the 
drawing, using the legal information provided, as shown in 
Figure 2–104.

Figure 2–104

3. Start the Line command. For the starting point, type 
6257490.0191,2037127.1292 and press <Enter>.

4. In the ribbon, in the Transparent Commands tab, click 

(Bearing Distance). 

5. For the first line, type the following:

• Quadrant: 3 (for the southwest quadrant)

• Bearing: 0.26422

• Distance: 922.4138

Stay in the Line command with the Bearing Distance 
transparent command running for the next few lines.

6. For the next two line segments, use the following values:

Quadrant Bearing Distance

3 0.24208 508.3493

3 66.03358 92.1845

Start point
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7. Press <Esc> twice to end the command.

8. In the Home tab>Draw panel, click  (Create Curve from 
End of Object). Select the last line that was drawn using the 
Bearing Distance command.

Remember to press 
<Enter> after you input 
a value.

9. From the command options, select Radius. Set the radius to 
627.1788.

10.From the command options, select Chord. Set the chord 
length to 455.6165.

11. In the Home tab>Draw panel, click  (Create Reverse or 
Compound Curve). Select the last curve drawn.

12.From the command options, select Reverse. Set the radius 
to 154.4828.

13.From the command options, select Chord. Set the chord 
length to 51.6.

14.Start the Line command. For the starting point, pick the 
endpoint of the last arc drawn.

15. In the Transparent Command toolbar, click  (Bearing 
Distance). 

16.For the remaining line segments, use the following values:

The legal description at 
the beginning of this 
practice was used to 
find the bearings and 
distances to type.

17.Press <Esc> once to exit the Bearing Distance transparent 
command. Hold <Ctrl> as you right-click and select 
Endpoint, then select the starting point of the parcel to close 
on the point of beginning.

Quadrant Bearing Distance

3 89.25446 724.9442

1 0.11099 1904.2647

2 61.50153 135.9034

2 64.05358 77.8201

2 78.09292 63.8821

2 66.23195 379.2248

2 66.17174 278.5122
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18.Start the Polyline Edit command by typing PE. In the model, 
select one of the lines or curves you just created and press 
<Enter> to turn it into a polyline.

This prevents closure 
errors from occurring 
later. 

19.Select the Join option and then select all of the lines and 
curves you just created. Press <Enter> to create one closed 
polyline. Press <Esc> to end the command.

20.Save the drawing.

21. (Optional) Save the drawing as <Your Initials>-Survey- 
Complete.dwg in the C:\Civil 3D Projects\References\DWG\ 
Survey folder.

22.Update the relative paths of the referenced drawings in the 
alert box.
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Chapter Review Questions

1. If you need linework, which method should you use to import 
survey data?

a. Import survey data using the Survey Database.

b. Import survey data using the Import Points command.

c. Import survey data using the Map Explorer.

d. Create points using the Toolspace, Prospector tab.

2. If you need to analyze the field data using the analysis tools 
available in the Survey Database, you must use a field book 
file rather than a text file.

a. True

b. False

3. Which of these is not a type of point object within the 
Autodesk Civil 3D software?

a. COGO Point

b. North Point

c. Survey Point

d. AutoCAD Point

4. Which of these is NOT an option within the Description Key 
manager?

a. Rotating the Point

b. Changing the Point Full Description

c. Deleting the Point

d. Assigning a Point Label

5. Which tab in the Point Label Style Composer dialog box 
controls the appearance of a point label when the point label 
grip is selected in the drawing and moved away from the 
point itself?

a. General tab

b. Layout tab

c. Dragged State tab

d. Summary tab
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6. How do you control the next point number to be used in a 
drawing?

a. The Point Identity parameters located in the expanded 
area in the Create Points toolbar.

b. Under Label Styles in the Toolspace, Settings tab.

c. In the Toolspace, Survey tab, right-click on Survey Points.

d. In the Toolspace, Prospector tab, right-click on Survey 
Points.

7. Can the _All Points point group be deleted?

a. Yes

b. No

8. Can a point group be made out of point groups?

a. Yes

b. No

9. How do you draw a parcel boundary from a legal description 
in the most efficient way possible?

a. Calculate the Cartesian coordinate angle for each bearing 
or azimuth within the legal description and type 
(distance)<(angle) for each line or curve.

b. Calculate the Cartesian coordinate angle for each bearing 
or azimuth within the legal description, place the cursor in 
that direction, and type the distance.

c. Use the extended Lines and Curves options in the Home 
tab>Draw panel or Transparent commands in the Line or 
Polyline command.

d. There is no fast way to do this.
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Command Summary

Button Command Location
Create Points • Ribbon: Home tab>Create Ground Data 

panel

Import Points 
from File

• Ribbon: Insert tab>Import panel

• Toolbar: Create Points

• Command Prompt: ImportPoints

Bearing 
Distance

• Toolbar: Transparent Commands

• Command Prompt: ’bd

Create Curve 
from End of 
Object

• Ribbon: Home tab>Draw panel

• Command Prompt: 
CurveFromEndOfObject

Import Survey 
Data

• Ribbon: Home tab>Create Ground Data 
panel

• Command Prompt: ImportSurveyData

Survey • Ribbon: Home tab>Palettes panel

Survey User 
Settings

• Toolspace: Survey tab

Zoom To 
Points

• Toolbar: Transparent Commands

• Command Prompt: ’ZTP
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